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General overview 4

1 General overview

Note: this documentation applies to ASE Scorer 8 release 1.0.43.0 or Service

pack 43 or more recent and Bridgemate Pro controller 1.6.16 or more recent.
I n many situations those releases or more recent are required for the features
to be available.

The key idea behind Bridgemates is that the scoring program, ASE Scorer 8, isin
charge and all "thework" is done using ASE Scorer 8.

To use Bridgemates with the ASE Scorer 8 you must tick the option "Use
Bridgemates for score entry”. Thisisfound on the main screen [Club F3]
[4Options] at the bottom of the screen. This option is set once and will remainin
force until un-ticked. Two new options will appear once this option is ticked.
They are[EventF2][2Names|[Get BM names] and

[EventF2][3Scores|[ Bridgemate].

Before you can score any event you need to know the details of the session. Of
course, you may not know all the details until everyone has sat down and you are
just about to start the session. However, you can get them started and then put in
the information about the session, as they will not need to score for another 6 or 7
minutes. This even applieswhen the players are required to enter their player
numbers. This can be done asthe first results are entered. It is suggested that you
do not enter the movement until play has started and you are no longer accepting
any latecomers.
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Using Bridgemates with the ASE Scorer 8

" | BMPro
{Bridgemate Pro \

controller) T Ty
program

Bri d ge
ASE Scorer 8 Mate
Scorer program Database

The Bridgemate relationships between the various components.

The diagram above shows the Bridgemate devices on the tables (BM 1, BM2
etc.). These communicate with the server using wireless communications. The
server gathers all the scores etc. independently of the personal computer that
houses the two programs that do all the work. The personal computer and the
server are connected using a cable that is attached to the computer's serial or USB
port.

The two programs, BMPro and ASE Scorer 8, uses the common database to save
and communicate information such as scores and player numbers. The BMPro
program gathers the information from the server and placesit in the Database.
The ASE Scorer 8 gathers the information from the database and uses it within
the scorer to produce the results.

All theinformation relating to an event is stored in two places, the server and the
database. The two programs, BMPro and ASE Scorer 8, can be closed down and
restarted at any time and the process of scoring is not interrupted. The server
continuesto operate independently of the programs.

All control of the programsis through the ASE Scorer 8 scorer. ASE Scorer 8
will start BMPro, setup and define the database, retrieve the scores and produce
theresults.
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Using Bridgemates with the ASE Scorer 8

2.1
2.1.1

2.1.2

2.1.3

Pre-Session Preparation

Bridgemates
Setting up the Bridgemates

Switch on the Bridgemates by pressing OK. The following message should
appear on the screen: -

BRIDGEMATE PRO
V22.1a AU

(The 2" line indicates the firmware version and language which may
differ from that shown here)

Altering the Contrast

Pressthe + or — key repeatedly to adjust contrast (do not press and hold either the
+ or - key).

Setting the Group (ie Section), Table & Channel

While the BRIDGEMATE PRO message ison the screen insert the TD key (if
message has disappeared, press OK to awaken the Bridgemate). A message
similar to that below will appear:-

| GROUP: A +/-
TABLE: 1

Press +/- to alter the Group (Section) letter. If one section then A; if more than
one (max 26), sections must be consecutive (eg A, B, C); then OK

Cursor now flashes at Table No.

To alter the Table Number, press CANCEL to delete current number, enter the
required Table Number, and then press OK.

The following message now appears. -
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Pre-Session Preparation 8

CHANNEL: 0

If only using one server, select O; then OK. If using more than one server, it is
advisable to have each server on adifferent channel (8 available; numbered 0-7).
To change channel, press CANCEL to delete the current channel and then enter
number (0-7) for required channel. Press OK; and the message SETTINGS
SAVED appears. After afew seconds the message shown in 2.1.1 appears.
Removethe TD key.

2.2 Servers

2.2.1 General information

Each server can service up to 128 Bridgemates simultaneously.

A server has an uninterrupted range of ~100m, but this can be reduced
severely if the signal had to pass through walls or partitions.

Theserver MUST be connected to the mainswhen in use. Batteries are
only for back-up in an emergency (e.g. power failure).

At the end of a session, disconnect the mains supply and remove one battery
from the server (screwdriver or other suitable device).

The server should be at located at least 12" from any el ectronic equipment
(e.g. computer).

The server should be placed horizontally on alevel surface.

Do not place any object on or near the server.

Server connectsto the PC viaaserial port. If your computer does not have
aserial port you will need aUSB — Serial Converter (see Bridgemate Pro
manual p8 for details).

2.2.2 Setting up the Server

Insert battery into the server; red light will come on.

Connect to mains and light will turn green.

Connect server to computer viathe serial port of the computer (or viaUSB
— Seria Converter).

Place server in asuitable position (see above 2.2.1)
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2.3
23.1

2.3.2

2.3.3

Check Communications & Set BMPro Preferences
Communication

After the server & the bridgemates are all set up start Bridgemate Pro Control
using BMPro.exe.
Check that the Bridgemate RF server is connected — top left-hand pane

Preferences

Click on Tools> Options; the following screen appears: -

[Geneial ]| Brdgemate |

[~ Drisable server detection
[Dioes not disable server debection & starhup)

[ Sheovs report weheen movement updated by edenal program

Uze Bndgemata Pro settings specied by
% Sesdng progam
" Budgemate Pro Control

Cancel | o |

On the General Tab, tick "Show report when movement updated by external
program”. "Tick Scoring program" so the Bridgemate Pro settings are specified
by the ASE Scorer 8. Press[OK].

Thisway the Bridgemate Preferences are set viathe scoring program and thereis
no need to alter any of the options given in the Bridgemate tab.

Setting the Channel

The server must be on the same channel as the Bridgemates it is communicating
with. To check or alter the channel, select Server from the Menu Bar > Channel
selection. The"Current channel” function displaysthe current channel. To alter
the channel, select the new channel and click Set then Close.

Close Bridgemate Pro Control using File > Exit.
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Using Bridgemates with the ASE Scorer 8

Initial session settings

Setting Preferences

The Bridgemate settings and options are only available when you have an event
open. Once the settings are established it is unlikely they will need changing
again. Therefore whenever the Bridgemate score option is sel ected the screen that
appear issimple. [Auto start] will perform the required steps needed for most
events and situations.

" BridgeMate. .. C:\ASESData\Events\Pairs 5T H2.bws

Select [Advanced] to see the available options (and then [simpl €] to hide the
options). They appear as. -

] BridgeMate. .. C:\ASESData\Events\Pairs 5T H2.bws

e x swe |

o stait oplions sl atup oplions
i Cieate database Create database fos the cuent session
[ Load session
Capate
W St Bridgehate =
[ Commence reading Load database with the
Bridgelste st options cutient session detals
W Open datzbass BridgeMate settings al staitup: ﬁ
[ Indtiskze -
¥ Stan capluse Setlings Start Eridget ste program
W Minimize Shart
Reading options

Time between reads of Bndgemate scores Seconds, 4 %} Start/stop seading EridgeMale scores

A
™ Shew lole Lables on eveiy Zed resd M

W Auborrescore session on every Sid iead ™ Resead il scoree

Path to Bidgehate database [ Use single dalabase file for the sesson
[C\ASEEData\E verts |

File path and name for the Bridgahate progiam

| C:\Peogranm Filez\Bridgamate Prot\BMPro.exe H_]

Set up preferences asrequired. The most essential item isthe last one "File path
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Initial session settings 12

and name for the Bridgemate program". The default value should be correct if the
BMPro controller was installed using the standard procedures. To change this
value click on the button to theright [ ...] to browse for the Bridgemate Pro
program on your computer. The path shown aboveistypically the location where
you would find the program BMPro.exe.

The other path required is" Path to Bridgemate database”. This may change as
your needs change but typically would be as shown above. The manual startup
options on the right should only be used by persons who understand the
procedure completely. These arefully explained in later chapters of this
document. The [Auto start] option isthe normal button used at the start of an
event. The "Auto start options' on the left should all be ticked and apply when
the [auto start] button is pressed. The "Bridgemate start options' only apply to the
Bridgemate Pro program when started by ASE Scorer 8 and are all normally
ticked.

The reading options may be changed as needed and during the running of an
event. The seconds between reads should be set to a number that satisfies your
needs. If you want to see the results frequently and while play takes place then
tick the "auto rescore session on every third read" option.

The settings for the Bridgemate program may be changed using the [ settings]
button. These preferences may be changed from event to event, but once an event
has started and the information has been sent to the bridgemates, the preferences
cannot be altered for that event.

] BridgeMate settings
[Crata entiy oplions Reezdts dizplay
W Show pars numbess each round [+ [List resuits of te board pest played
W Enber lead coed I~ Check board oider W Show yous cwn resulls in the st
¥ Enterplaper numbess [ Blank numbess alowed [ Show pescentage of the board just plaved
Erter resuks as Shiows the score for Shiows cortract using
™ Tocks waon verses cortiact " Meuth-South % Symbols
% Total ticks won (% Declae " Lelters
2 Time verlicalion message it dhown |27 seconds] | 0 Masdmum rumbser of resulls shown (O=al)
™ Send contract and bead mrmedisbely alter ertiy [~ Be sble to repest resdls deplay
[ 20 Timeinseconds 1o power off [5-60] W Group sl sections together [show scoies acioss the field)
co
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Change these setting to suit your needs. These options will override the

Bridgemate settings (see 2.3.2 Preferences above).
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4.1

Event Details

Start ASE Scorer 8 and click on the [New event] option on the main screen.
The event wizard steps you through the process of creating the new event. In this
part we will deal with setting up a single session, one section pairs event.

Thefirst screen isthe event details. Click "pairs' event, and [next]. The session
details appear. Change the details as needed, make sure the number of winnersis
correct (1 or 2) and press [next].

Section Movement Details

Complete the movement screen and click "Next".

Note the section identifiers include aletter, which by default will show "A". This
corresponds to the letter in the Bridgemates, each identified by aletter and table
number. Within BMPro this|etter corresponds to the section numbers so that A is
section 1, B is section 2 etc.

Note: These section numbers within BMPro do not match directly to the
section numberswithin ASE Scorer 8.

The letter used in the section properties within ASE Scorer 8 allows the
director to control which sectionsin ASE Scorer 8 correspond to which
sections within the playing room. Normally the director chooses section 1
in ASE Scorer 8to be section "A" and section 2 "B" etc. for convenience
and ease of memory but they can (as an example) be the other way
around. More importantly, when there are several events being run in the
one room using one Bridgemate server it is not possible for the section
numbersin all eventsto correspond to the letters in sequence (see chapter
8 and particularly 8.2 " Each section isindependent =r|").

Click [Finish] in the last screen of the section definition.

Y ou will be asked to save and name the event. Thisis required when using the
Bridgemates because ASE Scorer 8 needs to know the name of the event to name
the common database file used by ASE Scorer 8 and BMPro.

If you need to define more than one section in this session of play use the normal
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Event Details 16

ASE Scorer 8 options. Select [Section][New] to define a second and any
subsequent section in the session of play.

Once the session of bridge and al the sections have been setup in ASE Scorer 8
then the bridgemate program (BMPro) will need to be started.

4.2  Start Bridgemate session

At this point the event is no different to any other that you will scorein ASE
Scorer 8. To use the Bridgemates you must connect the server to the computer
and plug in the power lead of the server.

Then start BMPro program by selecting the option [event][Bridgemate] or
aternatively usethe [3scores|[ Bridgemate] button. The main Bridgemate screen
appears as shownin 3.1 abovelul. Click [Auto start] and the BMpro program
will start and initially show the BMPro screen while the tables are added to the
server but where "minimize" isticked in the options, it will shrink to the task bar
leaving the ASE Scorer 8 main screen showing. On the [3Scores] panel of the
screen the percentage of scoresread will be showing.

4.3 Player Name entry

At any time you can enter the players names. ASE Scorer 8 stopsretrieving
scores while you enter the names but will recommence scores capture when you
exit from the names entry.

Where you have the players entering their numbers on the Bridgemates you can
capture those player numbers at any time. Click the option [2Names][Get BM
names|] and you will be asked "Do you want to replace al the session names from
Bridgemates". Click [Y es] to proceed. This can be repeated at any time,
particularly where it wasfirst done before all the names have been entered by the

players.

4.4  Viewing the results

The results of the event may be viewed at anytime. Where you have asked for the
session to be "rescored every threereads" scoring takes place automatically. If
not, you will not need to rescore manually by pressing F6. Thefirst time ASE
Scorer 8 scoresthe session you will be notified that there are scores missing.
Click [ignore] so that dialogue will not appear again.
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The session report of results can be viewed any time by selecting

[6Report] [session] with the report destination set to "screen” and the report
selected set to "automatic”. Leave that report showing on the screen at all times
and the ASE Scorer 8 will refresh the display each time arescore occurs.

The report showing can be varied by using the "manual” report selection. Choose
areport that suits your needs. Perhaps where the number of playersinvolved is
large a multi-column report may be a better choice so that all names appear on
the one page.
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5.1

5.2

Changing and Deleting Scores

If a score needsto be changed or deleted the best way isto make the change
ison the bridgemate terminal at thetable. Thisupdatesthe server, BM Pro
and ASE Scorer 8 —but there arelimitson this (See Section 11).

If you need to check or adjust a score in ASE Scorer 8, click on [Section][Board
Scores] or use F5. ASE Scorer 8 stops retrieving scores when you look at the
score sheets but does recommence score capture automatically upon exit from the
SCores screen.

If ASE Scorer 8 hasalready read the board result, it makeslittle senseto
changethe board result in BM Pro Control. It isalways better to change it
at the table (delete and re-enter) where you have not started the next round
or enter it directly into ASE Scorer 8in all other cases.

Changing scores in BM Pro Control

Use thiswith care. Right-click on the result you would like to change and select
Edit score. A detail screen will appear displaying all the score data. Y ou can
now edit the result using the following notation: In the NS/EW box enter the
Declarer; in the Result box: clubs = C, diamonds = D, hearts = H, Spades= S, no
trumps = NT, double = x, redouble =xx, pass = PASS. Enter a space between
thelevel of the contract, the denomination and double/redouble.

If aboard result is changed in BM Pro, the new result is not transferred to the
server/bridgemates. If you do need to update the server/bridgemates: -

From BM Pro > Menu Bar > Session > Synchronise Client — Server > Recovery
Tab > recover Server. Follow on-screen instructions >Close Report > Close
message screen.

Deleting scores in BM Pro Control

To delete aboard result, right-click on the score you would like to delete and
select Delete score. To delete multiple scores simultaneously, press and hold the
Ctrl key and use the left mouse button to select the scores you would like to
delete; right-click > delete. Deleted scoreswill also be deleted from the scoring
program even if the score has already been read and will aso be deleted from the
server/bridgemates.
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The Final Results

At the start of thelast round it isworthwhile reminding the player s that
after thelast board has been entered and verified they should then press
OK until the message " End of Session" appears.

Oncethe last result on the last round has been received, you should go to the
board scores screen (F5) and press "missing”. There should be no missing scores
except where the board has not been played.

Produce any reports you may require such as session and outright results, board
scores, web pages etc. If the event iscompletein every way then [File] [Finalize]
the event.

If the event is not complete (e.g. anext session is expected) then shutdown ASE
Scorer 8 leaving the event open so the event will be opened automatically the
next time you start.

In the BM Pro Control program click on File> Close then File > Exit to
shut it down (ignoring any message that datais still being retrieved). Itis
best not close by clicking on thered X at thetop right-hand corner of the
Sscreen.

Turn off the server, remove the batteries from the server (elseit stayson) and
pack away the table top devices.
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7.1

7.2

Setting up a Session in Advance

With no server attached, start ASE Scorer 8 and define a new event in the normal
way. The Bridgemates will not be used until you [Auto start] the BMPro program
and Bridgemate server.

Where the session has two or more sections use the [ Section][new] option to add
more sections. If the names are known enter the names for the sectionsin the
normal way.

Setting up a Bridgemate database in advance.

Sometimesit is desirable to setup the Bridgemate database in advance. After
setting up the event as described in 4.1 above |, select [event] [bridgemate].

Click on [advanced]. On the manual startup options on the right of the screen
click [Create]. A message is shown "Database file created", press[OK]. This
step will create the database file but the file is empty and unusable at this point.

Click on [Load] and the session and all its section details will be loaded into the
database. A message is shown " Session successfully loaded to BM database”,
Press [OK]. This database is now ready to be used by Bridgemate Pro and ASE
Scorer 8 programs.

Y ou can [closg] this screen and close the ASE Scorer 8 if you require. The event
and Bridgemate database is setup and ready to use |ater.

Starting the Event

With the bridgemates all in position, and server attached, open ASE Scorer 8 (if
not already open) and open the event created in 6.1.

Select [event][bridgemate] and click [Auto start].

Where the Bridgemate database has already been setup as described in 7.12] you
will be asked some questions.
"Do you wish to replace the movement in thisfile?' Answer [No]. This step has
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Setting up a Session in Advance 24

aready been doneasin 7.1, at previoustime.

"Do you wish to start Bridgemate Controller?'. Answer [Y es].
"Doyouwishtoinitialize the server (first time start)?'. Answer [Y es].

The startup will continue in the normal way and start capturing the scores from
the server and BMPro program.
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Two (or More) Sections 26

8 Two (or More) Sections

If running two or mor e sectionsthat are to be scored independently you
must run a separate ASE Scorer 8 event filefor each section. If you try to
run both sections using only one ASE Scorer 8 event, the program will
automatically scor e these sections across the field. Even whereyou select
" scor e sections separ ately” the scorer still treatsthe event asthough it is
onefield.

Note: To " score the sections separately” simply means the boards are different
in each section and the results are NOT to be combined and compared for
match point purposes. Even so the session total scores are comparable and
the session is scored acrossthe field.

8.1 Morethan one section in one single event

Follow the procedures outlined abovein 3.2 etc. There are no specia
considerations except in the | etter assigned to the sections. For ease of operation
and organisation use "A" for section 1, "B" for section 2 and so forth.

Bridgemates must be set up as Section A: tables1ton and Section B:
tables 1- m etc. to match the choices made in ASE Scorer 8.

The letter assigned in the ASE Scorer 8 section isthe letter applying to the
Bridgemate sections. It is possible to have section 1 in the ASE Scorer using
letter "B" and section 2 letter "C" and section 3 letter "A" or similar. The letter
can be changed at any time within ASE Scorer 8 by using the Section properties
option. It isalso possible to use letters that do not start with "A". For example
they could be"C", "D" and "E" or similar.

Noteif you have accidentally named two sections™ A", ASE Scorer 8 will
warn you and you will need to go to [section][properties] for section 2 (select
the correct one on [9Details]) and change the letter to " B" . Press [OK] and
try the [load] again.

Scoring, name entry and reporting are all the same as with a one section session
inasingle event.
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8.2

8.2.1

Each section is independent

Treat this astwo (or more) separate events with separate results - not scored
acrossthefield. This method assumesthat the two sections are in one room
using one server (or in two separate rooms but still using only one server).
Bridgemates must be set up as Section A: tables1ton and Section B:
tables 1- m etc. to match the choicesmadein ASE Scorer 8.

To setup these types of eventsthe procedures outlined in 6 Setting up a session
In advance is used with some extended requirements. Firstly an event is setup
with the first section you require. The Bridgemate database is created for that
event. Then the other events are setup to cater for the second and subsequent
sectionsto be played in those separate events. The section lettersused in all
sectionsin al the events must be different from each other. These events are
added to the Bridemate database created for the first event. See these stepsin
detail below.

Setup an event for the first section

With no server attached, start ASE Scorer 8 and define anew event in the normal
way and as described in 4.1/ and 4.2/:] above.

Note: the session in the first event may have two or more sections to be scored
acrossthe field and so use the [ Section][new] option to add more sections as
required. Thefirst section is" A", second " B" etc. In other words the first
event (and any of the subsequent events) can be setup asdescribed in 8.1.

Save and name the event as required in the normal way. Then you must define
the Bridgemate database for all the events.

Select [event][bridgemate]. Click on [advanced].

Tick " Use single database file for session™ . Y ou will be asked for the location
and name of the file. Choose something unique and meaningful for the session of
play. Press[Open]. Y ou are asked "Database file does not exist. Do you wish to
createthisfile?' Click [Yes]. A message shows: "'Databasefile created”. Press
[OK]. This step has created the database file you have just named, but thefileis
empty and unusable at this point.

Click on [Load] and thefirst event's session and all its section details will be
loaded into the database. A message is shown 'Session successfully loaded to BM
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database'. Press [OK]. This database is now ready to be used by Bridgemate Pro
and ASE Scorer 8 programs to score the first of the events you intend to play.

Select [closg] for this screen. The Bridgemate database is setup and ready to use
for the first event. This event now represents the first section of the sectionsto be
scoredindependently.

8.2.2 Create the event for section two

Select [File][New] (save the current event if asked) and setup a new event with a
section that matches the requirements of your second ("B") section. Make sure
the letter for this section is correct ("B" in this case). Save this event with aname
that suits the second section.

Select [event][bridgemate]. Click on [advanced]. Make sure the option: " Use
single database file for session" istill ticked. Click [Load] and the second
event'ssession and all its section detailswill be loaded into the common
database. A message is shown 'Session successfully loaded to BM database'.
Press[OK].

8.2.3 Create the events for third and subsequent sections

Follow the same procedures as used in 8.2.2 for all the remaining sections
required for the session of play. Make sure you assign the correct lettersto the
sections. Once all the events/sections have been setup correctly we are ready to
start the session of bridge.

Where this has been done well before the event starts we are in aposition to close
down ASE Scorer 8 if we need. The events are setup and the Bridgemate Pro
database has been setup ready to roll anytime.

If need be you can enter the players names for each section in the normal way.
Note each time you open these events you will be asked "Do you want to start
reading current single Bridgemate database?'. Always Click [No] until the
session of play commences.

8.2.4 Start the BMPro program and the bridgemates

Onceyou have all the events/sections setup you are ready to start the session of
bridge. With the bridgemates all in position, and server attached, open ASE
Scorer 8 (if not already open) and open thefirst event.
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Note: Where you have closed down the ASE Scorer 8 and start afresh you will
need to establish the common database. Select [ Event][bridgemate][advanced]
and tick the option " Use single database file for session" , opening the same
database file you were using before.

Select [event][bridgemate] and click [Auto start].

"Do you wish to replace the movement in thisfile?' Answer [NO].

"Do you wish to start Bridgemate Controller?'. Answer [Y es].
"Doyouwishtoinitialize the server (first time start)?'. Answer [Y esg].

The startup will continue in the normal way and start capturing the scores from
the server and BMPro program.

Hint: it is possible to startup the BMPro controller using manual procedures:

Slect [event] [ bridgemate] [ Advanced]. Make sure the "Bridgemate start
options" have the 'open database, 'initialize' and 'start capture' options
ticked. Click [ Sart] in the "Manual startup options'. The Bridgemate Pro
Controller programwill start and show the tables being added to the
server.

Now start ASE Scorer 8 reading the scores from the database. Click [ start
read].

Only the event that is currently open in ASE Scorer 8 will capture scores from
the BMPro database. Therefore to get the scores for all the events you need to
switch between events. The most efficient way isto use keyboard short cuts.
Press and hold the [Alt] key and press"F" (for file) and then"1", "2" or "3" etc to
open the event in the list at the bottom of the menu. The 1" will open the event
with "1" showing next to it. With BMPro running, each time you switch events

A SE Scorer 8 will start reading the results for the open event.

Hint: The easy way to step through all events is to use [Alt]-[f]-[no. of
events]. E.g. with 2 events you always open the other event with [Alt]-[f]-
[2]. Similarly with three events use [Alt]-[f]-[3] to cycle through the three
events.

Note: as each event is opened the previous event will need to be saved
otherwise the scores captured will be lost. Y ou will be asked "Do you want to
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savethe event?' Answer [Y es] or press [enter].

Hint: select [File][Automatic save]. With this option ticked the save will
happen every time without any question.

Note: if the BMPro program is not running, each time you change events you
will get a message " Do you want to start reading current single Bridgemate
database?" . Click [Yes] or from the keyboard simply press[Enter].

To score the event press [F6] and to see the results press[F7]. This procedure
should only be needed at or near the end of each round for each event.

Hint: tick "Auto re-score session on every 3" read" and the scoring will
take place without any intervention. Press [F7] whenever the session
results are required.

At the end of each event produce the final results. Have the playersin each event
finish off the Bridgemate sessions, finishing with an "end of session" message.
Only close BMPro when all the events are finished. Then follow the procedures
outlined in part 5 above.

8.2.5 Re-Starting the BMPro program with multi-events

If you close ASE Scorer 8 for some reason the procedure for starting up again is
the same as usual. Also see @m for asimilar situation. The only thing that i<
different isto set (tick) the "Use single database file for session” option in
[Event][ bridgemate] [advanced], opening the same database file you were using
before. Y ou need to do this before you [auto start] the Bridgemate session as
explainedin 12.4.

If the BMPro program is still running when you restart ASE Scorer 8 follow the
same procedures but instead of using [Auto start] after ticking the "Use single
databasefilefor session” option only click [start read]. Where the event(s) have
not been saved before ASE Scorer 8 was closed it isimportant to tick "Re-read
all scores’, and then click [Start read]. The Bridgemate screen will close and
normal procedurescommence.

Where this has happened for more than one of the eventsthis procedure must be
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followed for each event. For each event select [ Event][bridgemate][advanced],
click [Stop read], tick "Re-read all scores’, and then click [Start read].
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Multi-Section Situations

When using bridgemates with ASE Scorer 8 an event isregarded either as. -
1. A singlesection
2. Two or more sections (whether pairs, individuals or teams) where the
results are scored acrossthe field to create asingle set of results.

More than one event can be scored at the same time using one server by opening
aASE Scorer 8 filefor each event. See part 7 above.

Itisextremely unlikely that you would wish to have a set-up like the one
described below. Itissimply anillustrative example: -

For example, if you wished to run the following using one server: -
PairsQualifying 3 sectionsto be scored acrossthe field

Open Pairs 2 sectionsto be scored independently
Swissteams 1 section

Y ou would need to set up 4 events: -

Event Description Bridgemate Section

1 Pairs Qualifying Section 1 Section A
1 Pairs Qualifying Section 1 Section B
1 Pairs Qualifying Section 1 Section C
2 Open Pairs Section 1 Section D
3 Open Pairs Section 2 Section E
4 Swissteams Section F

Each section within an event must have letter designations that are consecutive

The letter designation in Event 2 must follow on from the last | etter used in Event
1, etc.
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10

10.1

Swiss pairs

Swiss pairs events are handled routinely by ASE Scorer 8 and are no different
when using the Bridgemate devices. Create the event in the normal way for a
pairs event as described in section 4 above. The main difference is the choice of
and event type " Swiss pairs'.

The only complication occurs when the number of tables exceeds 45. The ASE
Scorer 8 has a section limit of 45 tables. Therefore when setting up an event with
more than 45 tables you will need to setup two or more sections. The pair
numbers must be unique acrossthe field. By default section 1 has aletter "A",
section 2 "B" and so forth and will be used by the Bridgemate devices as the
sectionidentifier.

When ASE Scorer 8 generates the draw for round 2 and higher it automatically
generates the first section with (up to) 43 tables and any tables higher than that
are placed in section 2 etc. (Note it is 43 because the minimum size section is 3
tables, so if you have exactly 45 tables there will be only one section of 45 tables
but if more than 45 it will be 43 + 3 or more). Again section 1is"A", 2 "B" etc.
Therefore for convenience to the organisers you should setup the first section
with 43 tablestoo. That means the table-top deviceswill beinitialy setto A 1
through 43 and B 1 through n etc. The Bridgemates will not change for the whole
event.

After setting up the first round (note " round” isthe same as" session” in ASE
Scorer 8 terminology) start the Bridgemate session in the same way as usual
using [ Event][ Bridgemate][ Auto start].

Round 1

Instruct playersto press[OK] on their Bridgemates until the table number and
pair numbers at that table are displayed so they can check they are all seated
correctly; if data on the screen is correct, then press[OK] again.

Towards the end of the round, instruct players to keep pressing [OK] after the
last board has been entered until the message End of Session appears, then press
[OK] again. When all scoresfor round 1 arein, score-up in the usua way (F6).

Close the BMPro program.

© 2007 ... ASE Computing



Swiss pairs 36

Produce your session results using the [report] [ session] option (F7).

10.2 Draw For Round 2

Produce the 2™ round draw using the [session][new] option and select [Y es]
when asked "Do you wish to produce and automatic Swissdraw?'. Thiswill
produce the second session section. Where there are more than 43 tables, the
first section has 43 tables, the second with next set of tables etc. Section 1 will be
"A", 2"B" etc.

Produce the draw report for the players. Where there are more than 43 tables,
showing the first section's 43 tables as 1-43, then the second section as 1-n etc.

Hint: it ispossible to use letters other than "A" and "B" etc for the sections.
Select the [ section][properties] for the respective sections and change the | etter
before the event is"loaded" to the Bridgemate database for each of the sessions.

10.3 Round 2 and other Subsequent Rounds

Start the Bridgemate session in the same way as session 1. Use
[Event][ Bridgemate][ Auto start].

Instruct playersto press OK on bridgemate until the table number and pair
numbers at that table are displayed so they can check they are all seated correctly;
If data on screen is correct, then press OK again.

Proceed in the same way asround 1. The report at the end of each subsequent
round is the [Report][Outright] report. The draw for each subsequent round isthe
same at the end of round 1.

10.4 End of Event

Towards the end of the round, instruct players to keep pressing [OK] after the
last board has been entered until the message End of Session appears, then press
OK again. When all scoresfor the last round are in score-up in the usual way
(F6).

Produce the Outright report to post the results. Close BMPro controller as usual.
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10.5 Advance Set-up

ASE Scorer 8 could be set up in advance of the tournament, but only if you are
certain that the number of tablesis correct. Without a server attached, set-up the
event in ASE Scorer 8 as described above in part 7/z!.
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11

Swiss teams

Swiss teams events are handled routinely by ASE Scorer 8 and are no different
when using the Bridgemate devices. Create the event in the normal way as
described in section 4 above. The main differenceis the choice of an event type
"Swissteams'.

The only complication occursin the organisation of the Bridgemate devices and
the letter or sections used. In the last screen of the session create use the [Teams
draw] button to view the draw and the table numbers assigned. On thislist of
options the last two are "Tables = teams" and "tables = matches". The default is
Tables = matches.

If you click "tables = matches" and then [apply re-number] you will have two
table 1 for the first match, two table 2 for the second etc. When the draw i<
published it shows both teams at table 1. When assigning the Bridgemate devices
to the tables of play you would chooseto use"A" 1 playing "B" 1 etc.

Note: it isessential you use tables = matches when the number of teamsis
odd. Thelast three teams can be involved in a three way match but the results
need to be scored and entered manually. The Bridgemates are not used for
these three matches. Using a bye for the last table eliminates thisissue.

After setting up thefirst round (note " round" isthe same as" session” in ASE
Scorer 8 terminology) start the Bridgemate session in the same way as usual
using [ Event][Bridgemate]. Then click [Auto start] and BMPro will startup in the
normal way. Note thiswill use the default table number and section letter
assignments.

Note to change the default letter and table numbers select [Advanced] and
click [Bridgemates]. This option isfound on the Bridgemate screen in the bottom
right hand corner titled " Teams event options'. Change the section and table
numbers to reflect the layout you are using in your Bridgemates. Thislist can be
quite arbitrary but some logical order would assist in the organisation. Press
[OK]. Then click [Auto start] and BMPro will startup in the normal way.

© 2007 ... ASE Computing



Swiss teams 40

11.1 Round 1

Instruct playersto press[OK] on their Bridgemates until the table number and
team numbers at that table are displayed so they can check they are all seated
correctly; if data on the screen is correct, then press[OK] again.

Towards the end of the round, instruct playersto keep pressing [OK] after the
last board has been entered until the message End of Session appears, then press
[OK] again. When all scoresfor round 1 are in score-up in the usual way (F6).

Close the BMPro program.
Produce your session results using the [report] [ session] option(F7).

11.2 Draw For Round 2

Produce the 2™ round draw using the [session][new] option and select [Y es]
when asked "Do you wish to produce and automatic Swissdraw?'. Thiswill
produce the second session (round). Produce the draw report for the teams with
the [reports][seating/draw].

11.3 Round 2 and other Subsequent Rounds

Start the Bridgemate session in the same way as used in session 1, using
[Event][Bridgemate].

Choose [ Advanced] so you can assign the Bridgemate devices to the
sections and tables using the [ Bridgemates| option. Change the section
and table numbersto reflect the layout you are using for Bridgemates.
Press [OK].

Click [Auto start] and BMPro will startup in the normal way.
Instruct playersto press[OK] on their Bridgemates until the table number and
team numbers at that table are displayed so they can check they are all seated

correctly; if data on screen iscorrect, then press[OK] again.

Proceed in the same way asround 1. The report at the end of each subsequent
round is the [Report][Outright] report.

Close the BMPro program, produce your session results and next round draw.
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11.4 End of Event

Towards the end of the round, instruct playersto keep pressing [OK] after the
last board has been entered until the message End of Session appears, then press
[OK] again. When all scoresfor the last round arein score-up in the usual way
(F6). Produce the Outright report to post the results. Close BMPro controller.

11.5 Set-up in advance

ASE Scorer 8 could be set up in advance of the tournament, but only if you are
certain that the number of tablesis correct. Without a server attached, set-up the
event in ASE Scorer 8 as described above in chapter 702,
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12

12.1
12.11

12.1.2

When Things go wrong

Changing the Movement

Movement sent to sever, but bridgemates not logged on.

Select [9Detalls] and click on the section 1, then click on the section you want to
change. Check the details of that section are correct. Then use the option

[ Section][replace] to re-enter the section details asrequired. You are asked if you
want to replace the current section, say [Y es]. Make sure you enter the correct
|etter for the section. [Finish]. Then the details of the current section should show
the number of tablesjust entered.

Select [ Event] [Bridgemate] and select the [ Advanced] option on the Bridgemate
screen. Click [load]. A messageisdisplayed:

BridgeMate Control isrunning.

If you proceed you will need to re-start BridgeM ate Control
with INITIALIZE set for these changesto take effect

and so lose any scores and player numbers already entered
Do you wish to replace the contents of the database?

[Yes] [NO]

Click [Yes| and see " Session successfully loaded to BM Database”. Press[OK].
Click [Auto start] and answer the questions:

"Do you wish to replace the movement in thisfile?' Answer [NO]

"Do you wish to start Bridgemate Controller?'. Answer [Yeg].
"Doyouwishtoinitialize the server (first time start)?'. Answer [Yeg].

When bridgemates|og on, they pick up the new movement.

Movement sent to server, bridgemates logged on, no results in.

Follow the same procedure asthat used in 12.1.1 above. The difference occurs
when the playerstry to enter information on the Bridgemates. They should try to
answer the questions on their tabletop devices asthough al is correct. As each
table is recognized by the server the tabletop device will be reset with the new
movement.
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If nameswere previously entered manually by the players on the Bridgemates
they will need to be re-entered.

12.1.3 Movement sent to server, bridgemates logged on, some results in.

There are basically two situations that you can encounter. Thefirst iswhere the
movement has changed including round 1 (or the current round in play). The
second is where the change will occur in round 2 (or the next round of play) and
after the 1% or current round finishes.

Normally the need for these changes will occur during round 1. It would be very
unusual for changesto occur after round 1 for many practical and usually
complex organisation reasons.

12.1.3.1 The movement change includes round 1

Thistype of situation includes simple and more complex situations. Both can be
corrected using the procedure outlinedin 12.1.2 above | but this method is
highly undesirable when there are more than one section in play and many results
have already been entered for al sections. With only one section involved, using
12.1.2 isequivalent to the procedure outlined here, except the results do not need
to be entered again.

An example of asimple situation is where amovement has started with a half-
table and new arrivalstake the place of the phantom pair and start play
immediately.

A complex situation might be where the director sets up the movement in ASE
Scorer 8 with 3 board rounds and physically distributes 4 boards per table.

Both of these need to be corrected on round 1. To correct the situation use the
standard procedure in ASE Scorer 8 to replace the section. Select [9Details] and
click on the section 1, then click on the section you want to change. Check the
details of that section are correct. Then use the option [ Section][replace] to re-
enter the section details as required. Y ou are asked if you want to replace the
current section, say [Y es]. Make sure you enter the correct letter for the section.
[Finish]. Then the details of the current section should show the number of tables
just entered.

Careis needed with board numbers. For example a 6 table share and relay
Mitchell that is modified to a6 %2 Table standard Mitchell. Table 7 isplaced in
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12.1.3.2

the movement with asitout. The boards on therelay are placed on table 7. Use
[ Section][board numbers] to change the sequence of board numbers before
updating the movement in Bridgemate Pro.

Once the movement is correct, select [Event][bridgemate] and click [Advanced)].
Note the panel in the middle headed " Change current session details'. Thefield
"Update from round" should normally show 2 asround 1 has commenced.
Changethisto 1. Click [Update] and a screen message then shows " This will
update from round 1. Do you wish to proceed?'. Click [Y es]. Where you have a
session where there are more than one section you will asked, for each section,
"Do you want to update from round 1 in section 1" etc. Click [Yes] for the
section(s) effected, [NQ] for the others.

BMPro controller may pop up amessage headed by "Report" showing the
movement has been updated by an external program. Click [closg] if
needed. This happening will depend on the BMPro [tools] [ options]
"General" in where " Show report when movement updated by external
program” is ticked.

When the playerstry to enter information on the Bridgemates they may find that
the sequence of questionswill differ from the normal sequence because they need
to re-enter some details. Initialy they should answer the questions on their
tabletop devices as though no change had been made. As each table is recognized
by the server the tabletop device will be reset with the new movement
information. Boards they have already scored will need to be re-entered.

In ASE Scorer 8 Bridgemate screen click [Stop read] (if it has been reading
scores), tick "Re-read all scores’, and then click [Start read]. The Bridgemate
screen will close and normal procedures commence.

The movement change commences with round 2

This procedure assumes that play isunder way in round 1 and some scores have
been entered. Examples of where this might occur include movements that have
started with all tablesfull and apair is added that will not be playing in round 1:
e With an even number of tables playing askip Mitchell, the new arrivals
areinstalled EW at anew highest-numbered table and an extra set of
boards placed on that table. Movement isturned into an odd-table
Mitchell with no skip.

e Inother Mitchellsthe new pair become a"rover" sitting out the 1% round
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e InHowell type movement, the new pair sits out the 1% round and are then
installed as astationary NS pair at atable that had 2 moving pairs.

To correct the situation use the standard procedure in ASE Scorer 8 to replace the
section. Select [9Details] and click on the section 1, then click on the section you
want to change. Check the details of that section are correct. Then use the option
[ Section][replace] to re-enter the section details asrequired. You are asked if you
want to replace the current section, say [Y es]. Make sure you enter the correct
letter for the section. [Finish]. Then the details of the current section should show
the number of tablesjust entered.

Careis needed with board numbers. For example a 6 table share and relay
Mitchell that ismodified to a6 %2 Table standard Mitchell. Table 7 isplaced in
the movement with asitout. The boards on therelay are placed on table 7. Use
[ Section][board numbers] to change the sequence of board numbers before
updating the movement in Bridgemate Pro.

Once the movement is correct, select [ Event][bridgemate] and click [auto start].
Y ou will be asked "do you wish to update the movement in thisfile?'. Click
[Yes]. A screen message then shows " Thiswill update from round 2. Do you
wish to proceed?'. Click [Yeg].

Note: If it refersto round 1 with the message " Thiswill update from round 1.
Do you wish to proceed?" . Click [NQ]. This generally meansno round 1
results have not been received yet and the procedurein 10.1.3.1 would apply.
Use the manual [update] option there using update from round 2.

Where you have a session where there are more than one section you will asked,
for each section, "Do you want to update from round 1 in section 1" etc. Click
[Y es] for the sections effected, [NO] for the others.

BMPro controller may pop up a message headed by "Report" showing the
movement has been updated by an external program. Click [close] if
needed. This happening will depend on the BMPro [tools] [ options]
"General" in where " Show report when movement updated by external
program" is ticked.

Entering the resultsin the Bridgemate devices will proceed as usual. The players
will not see any impact.
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12.2

12.3

12.4

If ASE Scorer 8 had been reading scores prior to this changeit will continue. If
not, select [Event][bridgemate] [Advanced] and click the [Start read] option.

A Bridgemate needs to be replaced during an Event

BM Pro Control select [Server] [Show Tables).

Select the relevant table and click "log off table(s) then follow on-screen prompts.
That bridgemate will now be logged off from the server.

Take another bridgemate and set (TD key) to correct section, table & channel.
Activate this bridgemate by pressing the OK button.

Server loses all Power

If server isdisconnected from power supply (mains & battery), al datait
contained will belost & bridgemates will not be ableto function. If youtry to
enter ascore in abridgemate the message "Failure to send data; retry?* will
appear. -

Reconnect server to power.

Go to BM Pro Control program. Select [ Session] [ Synchronise client — server]
and select the { Recovery tab}. Click [Recover server] [Yes] [Yes] [OK], Close
Report. Datafrom the results database file are copied to the server. Ensure BM
Proisretrieving data; if not, click { Retrieve dataicon} or [Session] [Retrieve
datafrom server] or F4.

Computer closes down during an Event

Ensurethat server retains power (mainsor battery)

Restart computer then restart ASE Scorer 8. |f message appears about ASE
Scorer 8 failing to close properly last time, ignore that with [No]. The event you
had open before the problem should be automatically open. If not open the event
in the normal way.

Select [Event][Bridgemate] from the main menu. Click [Auto start].

Y ou are asked "Do you wish to update the movement in thisfile?'. Click [No].
Next you are asked "Do you wish to start Bridgemate controller?'. Click [ Y eg].
Next you are asked "Do you wish to initialize the server (first time start)?'. Click
[NOQ].

The system is back and operating as before. Any results sent from the
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bridgemates to the server while the computer was down are now entered into BM
Pro and ASE Scorer 8. Using this method the server retains all the datait had
before the crash aswell as any results sent from the bridgemates while the
computer was down

12.5 ASE Scorer 8is closed inadvertently

The ASE Scorer 8 has been closed in the middle of a session and the BMPro
controller isstill running and the server is still operating normally.

Start ASE Scorer 8 in the normal way. The last event you had open should be
open but if not open the event in the normal way.

Select [Event][Bridgemate] from the main menu. Click [Auto start].
A message is shown saying "BridgeMate Control is running. Do you simply wish
to start reading?' Click [Yeg].

Where you are running several events using the same Bridgemate database, see
8.2.402 for more details.

12.6 Bridgemate controller program (BMPro.exe) is closed
inadvertently

The BMPro controller program has been closed in the middle of asession. ASE
Scorer 8 and the server are still running and operating in the normal way.

Select [Event][Bridgemate] from the main menu. Click [Auto start].
A message appears "Do you wish to start BridgeMate Controller?' Click [Y eg].
Next "Do you wish to initialize the server (first time start)?". Click [No].

Depending on how the BMPro program was closed sometimes the ASE Scorer 8
may think the BMPro program isstill running. Likely questionsinclude:

"Do you wish to update the movement in thisfile?'. Click [No].
"Bridgemate control isrunning. Do you wish to stop this bridgemate controller

session?. Click [Yes]. Then try this process again, select [ Event] [ Bridgemate]
from the main menu. Click [Auto start].
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13

13.1

13.1.1

Using the TD Key

Tournament directors have far-reaching powers to modify the entered scores. A
special TD menu isavailable for this purpose. To access this menu, use the TD-
key supplied with the package.

Insert the TD-key in the communication port of the Bridgemate. Thisrequires
the Bridgemate to be switched on and waiting for datato be entered. Itisfor
Instance not possible to activate the menu if the deviceisin the verification
screen or isdisplaying an overview of previousresults. WhentheTD key is
inserted, amessage "TD-MENU" appears on the screen.

To exit the menu, simply remove the TD-key.

TD Menu

When the Bridgemate shows BOARD / CONTR screen: insert the TD-key,
press on the relevant number and click "OK" to proceed. To escape at any
point, press CANCEL to return to the TD Menu screen.

Options are: -

1. Enter anotification for an arbitral score (first enter the board number then
insert the TD-key)

View results

Eraseresult

Show group/table number and round information

Show missing boards

arwON

0. ResetBridgemate

(1) Entering an arbitral score

If the board has already been played, the first step isto delete the current score
(see Section 3 below).

Enter the board number and confirm with OK. Insert the TD-key in the
Bridgemate to activate the TD menu. Press'l' and confirm (OK button) "Arbitral
score?' Thecursor is positioned at CONTR.

Next, enter the arbitral score for both pairs: NS: & EW.

Y ou can choose between 40%, 50% and 60%. Press4 or —to enter 40%, 5 or =
to enter 50%, 6 or + to enter 60%. It isnot possible to enter avalue other than
these percentages. Press OK after you have entered the percentage. Do thisfor
both pairs. The screen will now return to the TD MENU. Removethe TD key.
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13.1.2

13.1.3

13.1.4

The assigned arbitral scoreisnow displayed at CONTR. Press OK to confirm
this, and confirm the verification screen. The Bridgemate has now saved an
arbitral scorefor this board and will feed thisto the scoring program during read-
out.

(2) Retrieving overview

Insert the TD-key and press 2. Enter the corresponding board number. The
overview displaysthe pair number, direction of play, contract and result. If the
screen returns to the TD menu after the board number has been entered, no
scores will beregistered for this board.

(3) Erasing an entry

This can be aboard result from the current round or the previous round (if
previousround, then only if no boards have yet been entered in the current
round). To erase aboard input, press '3’ then OK when prompted to confirm,
"Eraseresult?' Enter the board number and confirm with OK. If that particular
board can be erased, the message "Board erased" will be displayed. If it isnot
possible to erase the score, the TD menu will be displayed again after you have
pressed OK.

Note

1. You can only erase or assign arbitral scoresfor aboard played in the
previousround if no boards have been scored during the current
round.

2. Youcanerasea"wrong" result to allow the playersto enter the
correct resultsor assign an arbitral scorefor boardsduring the
current round.

3. Onceitistoo lateto erase or assign an arbitral scorethe scorer must
be informed so that he can make the necessary adjustmentsin the
scoring program.

(4) Retrieving current status

If you no longer know to which table and section the Bridgemate relates, you can
retrieve thisinformation in the status part of the TD menu. To do so, insert the
TD-key in the Bridgemate and press'4'. Press OK when prompted to confirm
'Status? The expected table and section of the Bridge mate will be displayed
first. Press OK again to view the current round of the Bridgemate and the
corresponding pairs at thetable. Y ou will also see the boards played in this
round.
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13.1.5 (5) Overview of missing scores

From the TD menu, it is easy to establish which boards of the round have not yet
been entered. Press'5' and OK when prompted to confirm '‘Missing boards? The
Bridgemate will now display the numbers of the boards not yet entered in this
round.

13.1.6 (0) Resetting the Bridgemate

The Bridgemate can be reset from the TD menu. The reason for resetting the
Bridgemate device will vary but the most common one iswhere the deviceis not
responding in the expected manner. For example you cannot proceed with avalid
entry like Board Number [1] [OK].

To reset press'0' and OK when prompted to confirm 'Reset?
It will return to the main screen and proceed with the next expected response.
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